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Preface
NaturalONE is installed using the Software AG Installer, which you download from the Software
AG Empower website at https://empower.softwareag.com/.
This documentation provides product-specific instructions for installing NaturalONE. It is intended
for use with Using the Software AG Installer. That guide explains how to prepare your machine to
use the Software AG Installer, and how to use the Software AG Installer and Software AG
Uninstaller to install and uninstall your products. The most up-to-date version of Using the Software
AG Installer is always available at http://documentation.softwareag.com/ (Empower login required).
This documentation is organized under the following headings:
System Requirements

Supported operating system platforms and browsers. Java prerequisites
and hardware requirements.

Important Information

Important information that you should be aware of before you start the
installation.

Installing NaturalONE

Describes how to install NaturalONE with the Software AG Installer,
how to proceed after the installation, and how to uninstall NaturalONE.

Using Your Own Eclipse

Describes how to proceed if you want to use NaturalONE in your
existing Eclipse environment.

Using an Existing Natural
Lists the requirements if you prefer to use your own Natural
Development Server Environment Development Server (NDV) environment instead of the local Natural
runtime that is installed with NaturalONE.
Using an EntireX RPC
Environment

Describes how to proceed if you want to configure an EntireX RPC
environment (Broker and Natural RPC server) instead of using the
default configuration of the one that is installed with NaturalONE.

For important last-minute information, see the readme file that is provided with NaturalONE.
You can find it in the NaturalONE product documentation at http://documentation.softwareag.com/
(Empower login required).
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About this Documentation

Document Conventions
Convention

Description

Bold

Identifies elements on a screen.

Monospace font Identifies service names and locations in the format folder.subfolder.service,

APIs, Java classes, methods, properties.
Italic

Identifies:
Variables for which you must supply values specific to your own situation or
environment.
New terms the first time they occur in the text.
References to other documentation sources.

Monospace font Identifies:

Text you must type in.
Messages displayed by the system.
Program code.
{}

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

|

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

[]

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

...

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support
Software AG Documentation Website
You can find documentation on the Software AG Documentation website at https://documentation.softwareag.com.
Software AG Empower Product Support Website
If you do not yet have an account for Empower, send an email to empower@softwareag.com with
your name, company, and company email address and request an account.
Once you have an account, you can open Support Incidents online via the eService section of
Empower at https://empower.softwareag.com/.
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About this Documentation
You can find product information on the Software AG Empower Product Support website at https://empower.softwareag.com.
To submit feature/enhancement requests, get information about product availability, and download
products, go to Products.
To get information about fixes and to read early warnings, technical papers, and knowledge base
articles, go to the Knowledge Center.
If you have any questions, you can find a local or toll-free number for your country in our Global
Support Contact Directory at https://empower.softwareag.com/public_directory.aspx and give
us a call.
Software AG Tech Community
You can find documentation and other technical information on the Software AG Tech Community
website at https://techcommunity.softwareag.com. You can:
■

Access product documentation, if you have Tech Community credentials. If you do not, you
will need to register and specify "Documentation" as an area of interest.

■

Access articles, code samples, demos, and tutorials.

■

Use the online discussion forums, moderated by Software AG professionals, to ask questions,
discuss best practices, and learn how other customers are using Software AG technology.

■

Link to external websites that discuss open standards and web technology.

Data Protection
Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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System Requirements

Supported Operating System Platforms
NaturalONE supports the following 64-bit operating system platforms:
Microsoft Windows 10 Professional and Enterprise
Microsoft Windows Server 2016
Microsoft Windows Server 2019
Red Hat Enterprise Linux 7 and Red Hat Enterprise Linux 8 (x86-64)
SUSE Linux Enterprise Server 12 and SUSE Linux Enterprise Server 15 (x86-64)
Home Editions of Microsoft Windows are not supported.
For Windows, the runtime components of NaturalONE are always 32-bit applications, even on
64-bit platforms.
Notes:
1. We suggest that you install all of the recommended and important Microsoft Windows updates
before you start the installation.

Supported Browsers
Supported browsers in this version are:
Internet Explorer 11
Microsoft Edge
Mozilla Firefox Extended Support Release 78 (1)
Google Chrome (2)
Notes:
(1)

Only the Extended Support Releases of Mozilla Firefox are explicitly supported. Due to frequent
upgrades of the Mozilla Firefox consumer release, the compatibility of Natural for AjaxNaturalONENatural Web I/O Interface client with future versions of Mozilla Firefox cannot be fully
guaranteed. Possible incompatibilities will be removed during the regular maintenance process
of Natural for AjaxNaturalONENatural Web I/O Interface client.
(2)

The Google Chrome support is based on Google Chrome Version 91. Due to frequent version
upgrades of Google Chrome, compatibility of Natural for AjaxNaturalONENatural Web I/O Interface client with future versions of Google Chrome cannot be fully guaranteed. Possible incompatibilities will be removed during the regular maintenance process of Natural for AjaxNaturalONENatural Web I/O Interface client.
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System Requirements
Important: Cookies and JavaScript must be enabled in the browser.

Supported Natural Servers
To get the complete functionality of NaturalONE, specific Natural versions are required. For further
information, see Using an Existing Natural Development Server Environment.

Eclipse Prerequisites
NaturalONE is part of the Software AG Designer, which is based on Eclipse Version 4.19.
If you prefer to use NaturalONE in your existing Eclipse environment, Eclipse Version 4.19 is required. For further information, see Using Your Own Eclipse.

Java Prerequisites
On Windows, Java is automatically installed with NaturalONE when you start the Software AG
Installer GUI using the .exe file. No further steps are required. However, when you want to start
the installer using the .jar file instead of the .exe file, Oracle Java Version 11 must already be installed.
This is required to run the installer.
On Linux, Java is not installed with NaturalONE. Oracle Java Version 11 is required in this case.
You can download this from http://www.oracle.com/technetwork/java/javase/downloads/index.html.
Note: IBM Java or the GCJ Java should not be used with our products for Linux x86 and
x86-64 platforms. Use only Oracle Java for our products on Linux x86 and x86-64.

Hardware Requirements
Up to 3 GB of hard disk space are required for NaturalONE (Eclipse development installation
with service enabling and NaturalONE and EntireX runtimes).
Important: These hardware requirements are for NaturalONE only. They do not include any
additions such as RDBMSs. You must determine the overall hardware requirements depending on your development scenario.

Installation
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Important Information

Installation Directory
During the installation, you are asked to specify an installation directory. Specify the installation
directory in which to install your Software AG products. If you are installing NaturalONE on
Linux, the user that you are using to install must have full read and write permissions to this directory.
Important: It is recommended that you do not install into a directory which is a subdirectory
of a previous installation. Such a previous installation may have been created either with
the Software AG Installer or by an installation tool that was used in the past.

Side-by-Side Installations
It is possible to install side-by-side versions of NaturalONE on one machine. In this case, you have
to install each version into a separate directory.

Updating or Upgrading NaturalONE
As of NaturalONE Version 8.3.2, it is no longer possible to install a new version into the directory
which contains a previous version. Now it is only possible to do side-by-side installations where
each version is installed into a separate directory.
For each new version of NaturalONE, you have to use a different workspace. You must not use
the workspace of a previous NaturalONE installation.
After a new version of NaturalONE has been installed, you have to import your Natural projects
from the NaturalONE workspace of the previous version into the NaturalONE workspace for the
new version. In case you also make use of non-Software AG plug-ins, you have to reinstall these
plug-ins in Eclipse (via Help > Install New Software).
Important: When importing your old projects to the new workspace, make sure to enable
the Copy projects into workspace option.
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Important Information

Installing EntireX with NaturalONE
NaturalONE's Service Development functionality requires EntireX. If you plan to install EntireX
together with NaturalONE, read the information on EntireX in the Installing webMethods Products
guide before you start the NaturalONE installation. There you will find important information
on topics such as sudo authentication. The most up-to-date version of Installing webMethods Products
is always available at http://documentation.softwareag.com/ (Empower login required).

Online Help on Linux
In order to display the NaturalONE online help in Eclipse, it is required to set the Linux environment variable no_proxy in /etc/sysconfig/proxy to "localhost".

Installation
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Installing NaturalONE

Typical Development Installation
NaturalONE is part of the Software AG Designer. The following graphic shows the NaturalONE
components that can be installed with NaturalONE. The Application Development functionality
is mandatory; NaturalONE cannot be installed without this. The other components are optional.
Some of the optional components require that additional software is installed on a server. See also
What is NaturalONE? in the Introduction.

Installing NaturalONE Using the Software AG Installer GUI
This installation documentation provides just a brief description on how to install NaturalONE
directly on the target machine using the Software AG Installer GUI. For detailed information on
the Software AG Installer, see Using the Software AG Installer.
To install NaturalONE
Software AG provides a license file for NaturalONE; the installer requires it during installation.
Copy the license file to the machine on which you want to install NaturalONE. You can copy it to
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Installing NaturalONE
any temporary location. The installer will ask for the location of your license file and will then
copy it to the common/conf directory of your installation directory.
1

Start the Software AG Installer GUI as described in Using the Software AG Installer.

2

When the first page of the Software AG Installer GUI (the so-called Welcome panel) is shown,
choose the Next button repeatedly (and specify all required information on the shown panels
as described in Using the Software AG Installer) until the panel containing the product selection
tree appears. This tree lists the products you have licensed and which can be installed on the
operating system of the machine on which you are installing.

3

To install the full functionality of NaturalONE, you need to use Typical Installations and
the option NaturalONE Application Development Full Installation (see the description below).
All required items are automatically selected.

Installation
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Or:
Expand Designer > NaturalONE and select the product components that you want to install.
Application Development is always required. NaturalONE cannot be installed without this
item. It contains the core functionality of NaturalONE which consists of the basic functionality
for Natural application development plus the possibility to create rich internet applications
that use the Ajax technology. All other items under Designer > NaturalONE are optional
components for NaturalONE. See also What is NaturalONE? in the Introduction.
NaturalONE Runtime installs the integrated NaturalONE runtime environment (which is
also referred to as the "local Natural runtime"). If you want to use an already installed Natural
runtime on the local machine or on a remote machine, see also Using an Existing Natural
Development Server Environment.
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Installing NaturalONE
A Software AG-supplied Eclipse and a number of shared plug-ins are always installed with
NaturalONE.
Other items in the tree (such as EntireX) are only required for service development. They are
automatically selected when Service Development is selected.
Or:
Choose the Typical Installations button to display the following dialog box.

Select one of the following and choose the OK button:
■

NaturalONE Application Development
This installs the following, in addition to the Application Development core functionality:
Application Testing

■

NaturalONE Application Development Full Installation
This installs the following, in addition to the Application Development core functionality:
Application Testing
Mainframe Tools
Natural Construct
NaturalONE Runtime
Predict
Service Development
EntireX Workbench and many other items which are required by EntireX
Note: For NaturalONE, it is not required that you select EntireX in this dialog box.
EntireX is automatically installed with the Application Testing or Service Development
component of NaturalONE.

Installation
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4

Choose the Next button.

5

Read the license agreement, select the check box to agree to the terms of the license agreement,
and choose the Next button.

6

Enter the full path to the NaturalONE license file (or use the Browse button to select it from
a dialog box), and choose the Next button.

7

When a NaturalONE component was selected which requires service-enabling, a panel for
Platform Manager appears. Platform Manager is an agent that allows remote administration
of one or more selected products in this installation from Command Central. Select Install as
Service if you plan to use this capability, otherwise select Install as Application in order to
conserve system resources.

8

When EntireX was selected, additional panels appear. For detailed information on these
panels, see the Installing webMethods Products guide. The most up-to-date version of this guide
is always available at http://documentation.softwareag.com/ (Empower login required).

9

On the last panel, review the items you have selected for installation. If the list is correct,
choose the Next button to start the installation process.

Completing the Installation
After NaturalONE has been installed, you can start it as described in Starting NaturalONE which
is part of Using NaturalONE. NaturalONE's core functionality can be used without further configuration. Additional configuration steps, however, are required in the following cases:
■

You want to use an Eclipse other than the Software AG-installed Eclipse. See Using Your Own
Eclipse.

■

You installed a complete development installation, with or without the NaturalONE runtime,
and you also want to use an existing Natural Development Server (NDV). See Using an Existing
Natural Development Server Environment.

■

You installed the Mainframe Tools component. This component includes Mainframe Navigation,
which requires an Entire System Server environment. See Installation and Configuration in the
Mainframe Navigation documentation.

■

You installed the Natural Construct component, which requires a Natural Construct server environment. See Requirements in the Using Natural Construct section of the Code Generation documentation.

■

You installed the Predict component, which requires a Predict server environment. See Setting
Up a Predict Environment in the Predict Description and Generation documentation.

■

You installed the Service Development component, which requires a Natural Business Services
server environment. See Prerequisites in the Business Services documentation.
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■

You installed a complete development installation with service-enabling, but you did not install
EntireX because you want to use an existing EntireX on the local or a remote machine. See Using
an EntireX RPC Environment.

Preparing a Deployment Package
After installing NaturalONE and applying all current fixes to the installed version, you can prepare
a compressed package of NaturalONE. The idea is to simplify and speed up the deployment of
NaturalONE to additional development stations. No installation step is required, and these stations
do not need access to the internet. Another advantage is that you can install additional Eclipse
plug-ins which are distributed as well.
By copying and uncompressing this package into a directory on the development station, the "installation" of NaturalONE is finalized.
The required scripts are available at <installdir>/naturalone/scripts/ReducedFootprint.
On Windows, for example, start within this directory the script create_package.cmd. The result is a
compressed file named ONE-<vers.no>small.tgz. Copy this compressed file and the script extract_package.cmd into the appropriate directory on the other development station and execute the script.
NaturalONE is now operable.
The created package works only if you have installed the Application Development and Application
Testing components. If you want to use service generation locally, you still have to do a NaturalONE
full installation.

Uninstalling NaturalONE
You uninstall NaturalONE using the Software AG Uninstaller. For information on how to use the
uninstaller, see the Using the Software AG Installer guide.

Installation
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Using Your Own Eclipse

The easiest and recommended way to install NaturalONE is to make use of the Software AG Installer. However, you may prefer to make use of your already existing Eclipse environment. In
this case, specific versions of Eclipse and Java are required. See Eclipse Prerequisites and Java
Prerequisites and in the section System Requirements.
If you want to use NaturalONE in your existing Eclipse environment, you need the NaturalONE
Eclipse plug-ins. To get them, it is required that you do a regular installation using the Software
AG Installer first. When the installation has completed, you will find the required plug-ins in the
installation directory of the Software AG Designer. They are stored in <your-installation-directory>/Designer/updates. Now, you have to proceed as follows:
1. Install all NaturalONE plug-ins in your own Eclipse.
You have to install the plug-ins in the following order:
a. com.softwareag.common.zipSee Note 1.
b. com.softwareag.lic.utils.zipSee Note 2.
c. com.softwareag.cis.ide-91.zip
d. com.softwareag.naturalone.natural.ide-one91.zip
When the above plug-ins are installed, you can install the other NaturalONE plug-ins in any
order you like.
2. Copy the file naturalone.properties from the /Designer/updates folder of the Software AG Designer
installation to the folder of your Eclipse installation which contains the file eclipse.exe. Normally,
this is the root folder of the Eclipse installation.
You can now use NaturalONE from within your own Eclipse environment.
Notes:
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1. com.softwareag.common.zip is not signed. Therefore you will see a warning dialog. Choose Install
anyway on this dialog.
2. During installation on the very first Available Software dialog, deselect the item Group items
by category. This action is only required for this plug-in.
3. It is currently not possible to apply corrections to your own Eclipse-ONE environment.
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Using an Existing Natural Development Server Environment

Prerequisites
If you prefer to use your own Natural Development Server (NDV) environment instead of the
local Natural runtime that is installed with NaturalONE, it is recommended that you upgrade
your Natural Development Server environment to the versions listed below. Only with these
versions, you will get the complete functionality of NaturalONE.
The recommended versions are:
■

Mainframe
Use one of the following combinations:
■

Natural Version 8.2.7 and cumulative fix 6.
Natural Security Version 8.2.7 and cumulative fix 6.
Natural Development Server Version 8.2.7.3 with the Natural Web I/O Interface.

■

Alternatively, use Natural Version 9.1.1, Natural Security Version 9.1.1 and Natural Development Server Version 9.1.1.
Important: When Natural Development Server runs on a mainframe, Unicode and code
page support must be enabled (with the Natural profile parameters CFICU and CP).

■

■

UNIX or Windows
■

Natural Version 9.1.2.

■

Natural Security Version 9.1.2.

■

Natural Development Server Version 9.1.2 with the Natural Web I/O Interface.

Servlet Container
■

Natural for Ajax Version 9.1.2 on Apache Tomcat 9.
Note: Apache Tomcat is required by Ajax Developer. Execution and debugging of rich
internet applications, however, can be done with any application server or servlet
container on which Natural for Ajax is running.

If the above mentioned Natural or Natural Development Server versions are not installed in your
environment, specific Eclipse functionality does not work. However, NaturalONE as such can be
used.
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Startup Transactions
When a NaturalONE client connects to a Natural server, any startup transaction program executed
on the server must meet the following conditions:
■

It must not perform any screen I/Os.

■

It must be executed only once (that is, the Natural system variable *STARTUP must be reset to
blank within the startup transaction).

■

It must terminate properly.

You have to check the source code of each startup transaction in question and, if necessary, change
it to meet these conditions.
If you adjust the relevant source-code sections within a startup transaction - in dependency of the
client type - you can use the Natural application programming interface (API) USR4218N in the
library SYSEXT. This API has to be invoked from within the startup transaction and provides you
with the client type.

Natural Security
When Natural Security is active in your Natural server environment, several actions in the Natural
Server view and in the Project Explorer view (such as upload and download) are controlled by
Natural Security. A utility profile for SYSMAIN is then required in Natural Security which has the
appropriate settings. For detailed information, see Protecting the Natural Development Environment
in Eclipse in the Natural Security documentation, which is part of the Natural documentation.
If the Natural Security settings are not appropriate, you may not be able, for example, to add
projects from the Natural server to the NaturalONE workspace.

Library Statistical Records on Mainframes
In order to reduce the number of Adabas calls and to improve the performance, it is highly recommended that you create a so-called "library statistical record" for every Natural library on the
mainframe. This ensures that data which is often used is kept persistently. Thus, when using
NaturalONE, there is no need to retrieve this specific information many times. To initialize the
statistical records, you have to invoke the program NDVCSTAR which is available on the mainframe.
For further information, see SPoD-Specific Limitations and Considerations in the Natural Development
Server documentation for the appropriate platform.

Installation
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Database Access
You can access Adabas databases when they are on the same PC as your NaturalONE installation.
However, in order to access remote Adabas database systems, Entire Net-Work is required. Currently, you have to configure your environment accordingly. For remote access to Adabas 6 (Open
Systems) or Adabas 8 (Mainframe), Entire Net-Work 7.3.2 or above is required.
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Using an EntireX RPC Environment

EntireX is required if you want to develop Natural business services and RPC clients with NaturalONE. This is supported by the optional EntireX and Business Services components of NaturalONE.
This is sufficient for testing RPC clients for Natural subprograms. Testing Natural Business Services
clients, however, requires an additional Natural Business Services installation as described under
Prerequisites in the Business Services documentation.
If you prefer to use a different EntireX RPC environment (Broker and Natural RPC server) instead
of the one that is installed with NaturalONE, specify this as follows for those components for
which you need a custom EntireX RPC environment:
■

RPC Environments Preferences
On the RPC Environments page of the EntireX preferences, add your custom RPC environment
to the list of predefined RPC environments (Window > Preferences > Software AG > EntireX
> RPC Environments).

■

EntireX Natural Wrapper
In the EntireX Natural Wrapper wizard (Generate Natural from Software AG IDL command
in the context menu of an IDL file), choose either an RPC environment from the list defined on
the RPC Environments preference page, or create a new RPC environment definition (which
is then added to the list on the RPC Environments preference page).

■

EntireX IDL Extractor for Natural
In the IDL Extractor for Natural wizard (which is started with New > Other > Software AG >
EntireX > IDL Extractor for Natural), choose either an RPC environment from the list defined
on the RPC Environments preference page, or create a new RPC environment definition (which
is then added to the list on the RPC Environments preference page).

■

Natural Subprogram Tester
If you run the Natural subprogram tester on a Natural subprogram (Testing > Test Subprogram
command in the context menu of the NSN file), specify your Broker ID and server address on
the Connection tab of the tester user interface.
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■

EntireX IDL Tester
If you run the IDL tester on an IDL file (Test Software AG IDL command in the context menu
of the IDL file), specify your custom Broker ID and server address in the tester user interface.

■

General EntireX IDL Preferences
On the EntireX preference page, define your custom Broker ID and RPC server address that is
to be used as the default RPC environment with the EntireX wrappers (Window > Preferences
> Software AG > EntireX).

■

IDL File Properties
In the properties of an IDL file (Properties command in the context menu of the IDL file), specify
your custom Broker ID and RPC server address that is to be used by the EntireX Wrappers for
this IDL file. You do this in the general EntireX section and in the EntireX Web Service Wrapper
section (on the Mapping tab).

■

WS-Stack Configuration Editor
In the WS-stack configuration editor, configure an EntireX web service (AAR file) to use your
custom Broker ID and RPC server. To do so, open the web service archive (.aar) and on the EntireX
Settings tab, specify your custom Broker ID and RPC server address to be used. Save the modified .aar file and redeploy it.

See also EntireX Workbench which is part of the EntireX documentation.
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